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Chapter 1: The Nature of Projects

FIGURE 1.1 In this figure, all tasks appear — those

with slack and those on the critical path.

FIGURE 1.2 When you apply the appropriate filter,

only the tasks that can’t afford delay appear in your

schedule.

FIGURE 1.3 The Gantt Chart bars represent timing of

the tasks in a project.

FIGURE 1.4 The network diagram resembles a flow

chart for work in a project.

FIGURE 1.5 The work breakdown structure chart

reminds you of a typical company’s organization

chart.

FIGURE 1.6 The outline format of a Project schedule

clearly shows the various phases of your project.



Dependencies among tasks have not yet been

established; every task starts at the same time, which

isn’t always possible.

FIGURE 1.7 The darker portion of each upper taskbar

and the percentageFIGURE to the right of each upper

taskbar indicate the percentage of each task that is

complete.

Chapter 2: Exploring the Microsoft Project Environment

FIGURE 2.1 Project's opening screen.

FIGURE 2.2 The Ribbon consists of tabs that contain

groups of buttons.

FIGURE 2.3 Buttons with arrows serve multiple

purposes.

FIGURE 2.4 You can add common commands such as

New and Open to the QAT by clicking the Customize

Quick Access Toolbar button.

FIGURE 2.5 The Mini Toolbar contains commonly

used commands, such as inserting or deleting a task.

FIGURE 2.6 In Project 2010, Backstage view replaces

the File menu.

FIGURE 2.7 When you enter information in the Gantt

Chart view, the split pane displays task details in the

Gantt table and bars representing tasks in the Gantt

Chart.

FIGURE 2.8 You can enter or edit text in individual

cells or in the Entry bar.

FIGURE 2.9 Use the Display options of the Project

Options dialog box to enable the Entry bar in every

project file.

FIGURE 2.10 To switch to a popular view, use View

shortcut buttons in the lower-right corner or the list



that appears at the bottom of the Gantt Chart button.

FIGURE 2.11 The Task Views group and the Resource

Views group (to the left of the View tab) help you

switch quickly to the most popular task and resource

views.

FIGURE 2.12 The More Views dialog box lists all of

Project's views, as well as any you might add.

Chapter 3: Creating a New Project

FIGURE 3.1 Select a template on which to base your

project.

FIGURE 3.2 Click Recent in the Backstage view to

see a list of the last 17 projects you opened.

FIGURE 3.3 Use the Open dialog box to navigate to

the folder where you store projects and select a

project to open.

FIGURE 3.4 The Project Information dialog box

tracks basic information about each project.

FIGURE 3.5 Use the arrow keys at the top of this

calendar to choose other months.

FIGURE 3.6 By reviewing the Calendar settings in

the Project Options dialog box, you ensure that you

and Project are speaking the same language when

you enter task-duration information.

FIGURE 3.7 The Schedule tab is where you modify

the default settings for entering tasks.

FIGURE 3.8 By default, Project displays the settings

for Standard (Project Calendar) in the Change

Working Time dialog box.

FIGURE 3.9 From the Create New Base Calendar

dialog box, you can create a copy of an existing

calendar or you can create a new Standard calendar.



FIGURE 3.10 To modify the default work week, select

[Default] on the Work Weeks tab.

FIGURE 3.11 Use this dialog box to redefine a work

week.

FIGURE 3.12 To set up a working time exception,

type a name for the exception and set dates.

FIGURE 3.13 Use this dialog box to define the

working time exception.

FIGURE 3.14 Project marks exceptions to the typical

schedule with an underscore.

FIGURE 3.15 Project highlights the duration and

dates of any changes you make that affect the project

schedule.

FIGURE 3.16 Note that each task is the same length

by default, and each begins on the project’s start

date.

FIGURE 3.17 When you insert a task, Project prompts

you to type a name for the new task.

FIGURE 3.18 The summary task now appears in

boldface type.

FIGURE 3.19 The outline structure enables you to see

summary tasks and subtasks as manageable chunks

of work.

FIGURE 3.20 The Timeline can present an overview

snapshot of your project.

FIGURE 3.21 You can copy the Timeline to other

Office programs.

FIGURE 3.22 Select a scheduling mode for all new

tasks in a project.



FIGURE 3.23 A project that uses manually scheduled

tasks.

FIGURE 3.24 A project that uses automatically

scheduled tasks.

FIGURE 3.25 Changing the outline structure of a

project that uses manually scheduled tasks converts

the summary task to an automatically scheduled task.

FIGURE 3.26 Change the scheduling mode of a task

using either the Task Mode column or the buttons in

the Schedule group on the Ribbon.

FIGURE 3.27 The New Tasks Created list box

controls whether Project uses manual or automatic

scheduling by default.

FIGURE 3.28 Use the Save As dialog box to tell

Project where to save a file and what format to use.

FIGURE 3.29 The Save Options dialog box.

FIGURE 3.30 I refer to this project as I make

adjustments to the outline.

FIGURE 3.31 The project after cutting a task and

pasting it in a new location.

FIGURE 3.32 Project indicates the proposed position

of the task with a horizontal gray line.

FIGURE 3.33 Both Book Meeting Space and Order

Food tasks have detail tasks beneath them.

FIGURE 3.34 Take advantage of the fill handle for

contiguous copy tasks.

FIGURE 3.35 Project fills the range with the selected

tasks.

FIGURE 3.36 Use the Show button on the View tab to

easily determine the level of detail that you want to



view in a project.

FIGURE 3.37 You can expand or collapse any task

that has a subtask.

FIGURE 3.38 The detail tasks are now hidden. The

plus signs and the summary-style bars in the chart

portion of the Gantt Chart view, however, indicate

that more is here than meets the eye.

FIGURE 3.39 You can use the Project Help window to

search both online and offline sources for help.

FIGURE 3.40 Project displays a list of topics after you

select a subject.

FIGURE 3.41 A typical Help topic.

FIGURE 3.42 Use the Help system’s search engine to

find Help topics on a subject.

Chapter 4: Building Tasks

FIGURE 4.1 Changing Project options to make all

new tasks effort-driven.

FIGURE 4.2 When you change a task’s duration,

Project highlights other tasks affected by the change.

FIGURE 4.3 If you double-click a task name you

already entered, it appears in the Name field in this

dialog box. If you double-click a blank task-name cell,

you can fill in the name here.

FIGURE 4.4 Task bars become more meaningful after

you assign durations.

FIGURE 4.5 If you’re a visually oriented person,

dragging task bars to change durations might be the

best method for you.

FIGURE 4.6 Use the Scheduling Options section in

the Project Options dialog box to change Project’s



default behavior when scheduling tasks.

FIGURE 4.7 Assign a calendar to a task from the

Advanced tab of the Task Information dialog box.

FIGURE 4.8 A milestone typically marks a noteworthy

point in your project; a milestone is usually a task of

no duration.

FIGURE 4.9 Using a summary task to represent the

total timing of its subtasks.

FIGURE 4.10 You can assign a duration to a summary

task.

FIGURE 4.11 Project tracks the information you

assign to a summary task along with its calculations

for the associated detail tasks.

FIGURE 4.12 If a task occurs at regular intervals

during the life of a project, you can save time by

creating it as a recurring task.

FIGURE 4.13 Task bars appear for each occurrence

of the recurring task in the Gantt Chart.

FIGURE 4.14 When you set a deadline date for a task,

Project displays an indicator to alert you that you’ve

set the deadline.

FIGURE 4.15 Click the arrow next to the Constraint

Type field to see the various constraints.

FIGURE 4.16 The Notes tab provides simple word

processing, such as tools for formatting your notes.

FIGURE 4.17 Project automatically adds an icon for

the note to the Indicators column.

FIGURE 4.18 Notes appear on a separate page after

printing your Gantt Chart when you check the Print

Notes option.



FIGURE 4.19 Multiple dependencies or a combination

of dependencies and constraints can cause conflicts

in timing.

FIGURE 4.20 Here, after you apply the chemical

solution, you must wait four days before analyzing

the results.

FIGURE 4.21 Some overlap — lead time — occurs

between the application of the chemical solution and

the application of heat in this testing project.

FIGURE 4.22 Four types of dependencies enable you

to deal with every variable of how tasks can relate to

each other’s timing.

FIGURE 4.23 In the FS relationship, successor tasks

can’t start until predecessor tasks finish.

FIGURE 4.24 The successor task can’t finish until the

predecessor task starts.

FIGURE 4.25 The successor task can’t finish until the

predecessor task starts.

FIGURE 4.26 The successor task can’t finish before

the predecessor task finishes.

FIGURE 4.27 The relationship isn’t established until

you release the mouse button. If you have second

thoughts, just drag the pointer back to the

predecessor task before releasing your mouse button.

FIGURE 4.28 Use this dialog box to establish task

dependencies or lag time.

FIGURE 4.29 Every task you create for your project

appears on this list.

FIGURE 4.30 Display the Predecessors column to

show all the relationships for a task.



FIGURE 4.31 You can use the Task Inspector pane to

explore task relationships.

Chapter 5: Creating Resources and Assigning Costs

FIGURE 5.1 The Resource Sheet displays a list of the

resources available to your project.

FIGURE 5.2 Use the General tab of the Resource

Information dialog box to add information about a

resource, such as an e-mail address or availability.

FIGURE 5.3 Use the Resource Availability table to

identify when a resource is available.

FIGURE 5.4 Specify whether to commit a resource or

simply propose its use.

FIGURE 5.5 You can assign custom fields to Generic

resources to describe the skills that are required.

FIGURE 5.6 Identify Generic resources by the icon

that’s shown in the Indicator column.

FIGURE 5.7 If you set up a Cost resource as a budget

resource, you can use it to budget for your project.

FIGURE 5.8 Use this text box to store information

about a resource.

FIGURE 5.9 No need to reopen the Resource

Information dialog box to read a note. Instead, place

your mouse pointer over the icon in the Indicator

column to display the contents of the note.

FIGURE 5.10 To modify the default work week, select

[Default] on the Work Weeks tab.

FIGURE 5.11 Use this dialog box to redefine a work

week.

FIGURE 5.12 To set up a working time exception,

type a name for the exception and set dates.



FIGURE 5.13 Project uses underscores to mark

exceptions to the resource’s regular calendar.

FIGURE 5.14 Use the Assign Resources window to

assign a resource to the task identified at the top of

the box.

FIGURE 5.15 To assign a budget resource, you must

display the project summary task.

FIGURE 5.16 You use the Assign Resources window

to assign a budget resource to the project summary

task.

FIGURE 5.17 You can use the Task Usage view or the

Resource Usage view to assign budget-resource

values to the project summary task.

FIGURE 5.18 You can narrow your search for

resources by filtering, and you can make additional

resources available.

FIGURE 5.19 This graph shows the amount of work

assigned to the resource you selected in the Assign

Resources window for the time period displayed.

FIGURE 5.20 Indicate variable consumption by

supplying the time rate when you specify the amount

that you'll use.

FIGURE 5.21 Remove resources from tasks by

selecting them in the Assign Resources window and

clicking Remove.

FIGURE 5.22 The Replace Resource dialog box looks

very similar to the Assign Resources dialog box.

FIGURE 5.23 Check the cost of your project in the

Project Statistics dialog box.

FIGURE 5.24 Use the Cost table view of the Gantt

Chart to assign costs to tasks.



FIGURE 5.25 Setting up a fixed-cost resource.

FIGURE 5.26 When you assign a resource with a

cost/use to a task, Project displays that cost in the

Assign Resources window.

FIGURE 5.27 Project assigns the cost per use to the

task when you assign a resource defined with a cost-

per-use value.

FIGURE 5.28 Use cost-rate tables to assign different

rates to a resource.

FIGURE 5.29 The Task Usage view shows you the

amount of time that a resource is assigned to a

particular task.

FIGURE 5.30 Use the General tab of the Assignment

Information dialog box to select a cost-rate table.

Chapter 6: Understanding the Basics of Views

FIGURE 6.1 Switch tables by choosing from the menu

that appears when you right-click the Select All

button.

FIGURE 6.2 The More Tables dialog box shows the

tables to which you can switch in task views; click the

Resource option to view the corresponding tables in

resource views.

FIGURE 6.3 Change the information that appears in

the Details section of the view by selecting from this

list.

FIGURE 6.4 The More Views dialog box lists all views

available in Project.

FIGURE 6.5 The Calendar view features a familiar,

easy-to-read format.

FIGURE 6.6 The Detail Gantt view.



FIGURE 6.7 The Gantt Chart view.

FIGURE 6.8 The Gantt with Timeline view

simultaneously presents a high-level view and a

detailed view of a project.

FIGURE 6.9 The Leveling Gantt view.

FIGURE 6.10 The standard Gantt view shows you the

reality of your project timing at the moment, based

on actual work done.

FIGURE 6.11 The Tracking Gantt view shows the

discrepancy between your estimates and the real-

world activity in your project.

FIGURE 6.12 The Multiple Baselines Gantt view

helps you compare the first three baselines you save.

FIGURE 6.13 The Network Diagram view.

FIGURE 6.14 You can see task details when you

examine the nodes of the Network Diagram.

FIGURE 6.15 You can group tasks in a variety of ways

in the Network Diagram view.

FIGURE 6.16 Add information to a cell of the

Network Diagram node.

FIGURE 6.17 Use this dialog box to add indicators or

a custom field to a Network Diagram node.

FIGURE 6.18 In this dialog box, select the template

you want to apply to selected types of tasks.

FIGURE 6.19 A Network Diagram that displays

indicators in the nodes.

FIGURE 6.20 The Descriptive Network Diagram view.

FIGURE 6.21 The Relationship Network Diagram

view helps you focus on a single task and the tasks

linked to it.



FIGURE 6.22 The Resource Allocation view displays

resource allocation relative to the project timing.

FIGURE 6.23 The Resource Form view.

FIGURE 6.24 The percentage of a resource’s

available work time is tracked and displayed as

overallocated or underallocated.

FIGURE 6.25 Displaying task information beneath a

Resource Graph shows you the work assignments

that are keeping the resource busy.

FIGURE 6.26 The Resource Name Form view.

FIGURE 6.27 You can view both standard and

overtime rates in the Resource Sheet view.

FIGURE 6.28 The Resource Usage view organizes

task assignments by resource so you can

easilyFIGURE out who’s doing what and when it’s

being done.

FIGURE 6.29 Use this dialog box to enable rollup

behavior for all tasks in your project.

FIGURE 6.30 In this figure, the outline is completely

expanded.

FIGURE 6.31 In this figure, I collapsed the outline for

the Selection task, but I didn’t enable rollup behavior.

FIGURE 6.32 In this figure, I collapsed the outline for

the Selection task and enabled rollup behavior.

FIGURE 6.33 The Bar Rollup view.

FIGURE 6.34 The Milestone Rollup view.

FIGURE 6.35 The Milestone Date Rollup view.

FIGURE 6.36 The Task Details Form view.

FIGURE 6.37 The Task Entry view.



FIGURE 6.38 The Task Name Form view.

FIGURE 6.39 The Task Sheet view helps you to see

tasks in chronological order.

FIGURE 6.40 The Task Usage view shows resources

grouped under the tasks to which they are assigned.

FIGURE 6.41 The Team Planner view.

FIGURE 6.42 Recording progress on the Team

Planner view.

FIGURE 6.43 The Timeline appears above the Gantt

Chart view.

FIGURE 6.44 A full screen view of the Timeline.

Chapter 7: Using Views to Gain Perspective

FIGURE 7.1 By default, Project widens rows to

accommodate long task names.

FIGURE 7.2 If you widen the Task Name column

enough, some rows can appear wider than they need

to be.

FIGURE 7.3 To control whether Project wraps text in

a column, right-click over the column heading and

use the Wrap Text command.

FIGURE 7.4 You can safely hide the information in

any column.

FIGURE 7.5 Inserting a column in between existing

columns.

FIGURE 7.6 You can use the Add New Column

feature to add a new column to the right edge of the

table.

FIGURE 7.7 The Detail Styles dialog box supplies

additional choices that you can display in the Details

section of a view.



FIGURE 7.8 You can hide fields in a Details section of

a usage view by selecting the field from the shortcut

menu that appears when you right-click in the Details

section.

FIGURE 7.9 Switch to a different table by selecting it

from this shortcut menu.

FIGURE 7.10 Select a table to use, edit, or copy from

this dialog box.

FIGURE 7.11 Use the Table Definition dialog box to

make changes to the appearance of a table. When you

create a new table, no information appears in the

bottom portion of the dialog box.

FIGURE 7.12 A timescale that shows each day of the

week.

FIGURE 7.13 The same project after using the Zoom

slider to zoom out.

FIGURE 7.14 In the Timescale dialog box, adjust the

units to display and set the heading labels and

alignment.

FIGURE 7.15 When you specify 1 week in the Count

field of the Timescale dialog box, Project marks off

every week on the portion of the timescale that

displays weeks.

FIGURE 7.16 Changing the number of weeks to 2 in

the Count field causes Project to mark off weeks in

two-week chunks.

FIGURE 7.17 A simple choice awaits you in the

Define New View dialog box: a single or combination

view.

FIGURE 7.18 Use this dialog box to name and

describe your new view.



FIGURE 7.19 A combination view displays

information for selected tasks.

FIGURE 7.20 In the combination view version of the

View Definition dialog box, select the two views to

place on-screen.

FIGURE 7.21 Using commands from the Sort

submenu, you can sort a project by Task Finish Date.

FIGURE 7.22 Use the Sort dialog box to set up a

more complex sort structure.

FIGURE 7.23 The WBS chart is reminiscent of a

company organization chart.

FIGURE 7.24 WBS numbering shows you the

hierarchical relationship of tasks in the project.

FIGURE 7.25 Use the WBS Code Definition dialog box

to define the type of WBS code you want to use.

FIGURE 7.26 When you display the WBS column,

Project displays the WBS codes for each task in your

project.

FIGURE 7.27 Because I moved tasks around, the

WBS codes are no longer sequential.

FIGURE 7.28 Use this dialog box to renumber the

project.

FIGURE 7.29 Select an outline code to customize.

FIGURE 7.30 Use this dialog box to define the

allowable lookup codes.

FIGURE 7.31 The Code Mask Definition dialog box

looks and operates like the WBS Code Definition

dialog box.

FIGURE 7.32 You can enter outline codes using the

entries listed in the lookup table.



FIGURE 7.33 Use the More Filters dialog box to

apply a filter that doesn’t appear on the Filtered For

list or to apply a highlighting filter.

FIGURE 7.34 The Filter Definition dialog box enables

you to edit an existing filter.

FIGURE 7.35 Select an AutoFilter.

FIGURE 7.36 Group tasks in a view to help you

identify information about your project.

FIGURE 7.37 Select a way to group information in

the view.

FIGURE 7.38 Use the More Groups dialog box to

apply a group not on the Group By list or to create a

new group by copying and editing an existing group.

FIGURE 7.39 Use this dialog box to create a custom

group based on an existing group.

FIGURE 7.40 Use this dialog box to specify the

intervals at which you want Project to group the

fields.

FIGURE 7.41 Use this dialog box to group by

assignment fields.

Chapter 8: Modifying the Appearance of Your Project

FIGURE 8.1 Find the Gantt Chart Wizard in the list

on the left and click Add to display the entry in the

list on the right.

FIGURE 8.2 The preview provides an idea of how

each option formats your Gantt Chart.

FIGURE 8.3 Placing text alongside task bars can be

useful with larger schedules.

FIGURE 8.4 Decide whether to display link lines to

indicate dependent tasks.



FIGURE 8.5 If you don't like what you see, move back

to the dialog box in which you made the original

setting, change the setting, and then move forward to

this dialog box again.

FIGURE 8.6 From the Font dialog box, you can

control the style, size, and color of fonts, as well the

background appearance of cells.

FIGURE 8.7 The default in the Item to Change list

box is All (that is, all the text in your project

schedule).

FIGURE 8.8 Here task names in italics with a red

background indicate critical tasks; noncritical tasks

have a pale blue background.

FIGURE 8.9 You can modify the appearance of an

individual task bar to draw attention to it.

FIGURE 8.10 Use the Bars tab of the Bar Styles

dialog box to change the appearance of an entire

category of tasks.

FIGURE 8.11 Be careful not to place too much

information around task bars or you'll create a

cluttered, illegible Gantt Chart.

FIGURE 8.12 Adding rows to each task can make

your schedule easier to read.

FIGURE 8.13 In the table, I changed the number of

rows for Normal tasks. At the bottom of the dialog

box, I added Baseline Duration to the bottom row of

Normal tasks.

FIGURE 8.14 Assign different colors to tasks on the

Timeline.

FIGURE 8.15 Change the border and fill color of

tasks in the Team Planner view.



FIGURE 8.16 Because layout affects different

elements in different views, the Layout dialog box for

the Gantt Chart view is different from the Layout

dialog box for the Network Diagram and Calendar

views.

FIGURE 8.17 Displaying additional gridlines can

make a schedule easier to read.

FIGURE 8.18 You can choose gridlines from five

different styles.

FIGURE 8.19 To modify the appearance of a single

box in the network diagram, use this dialog box.

FIGURE 8.20 Use this dialog box to select a category

of box to format.

FIGURE 8.21 Select a template to modify or copy, or

create a new template.

FIGURE 8.22 Use this dialog box to change the

information you show in network diagram nodes.

FIGURE 8.23 Use this dialog box to change the

number of cells in a node.

FIGURE 8.24 You can control layout mode, box

arrangement, and link style for the network diagram.

FIGURE 8.25 By adjusting the layout of the network

diagram, you can dramatically change its

appearance.

FIGURE 8.26 Use this dialog box to change the

appearance of the Calendar view. Assign different

font colors to different task types, or use a line

instead of a bar to represent the task's duration.

FIGURE 8.27 You can create custom Calendar views

to help you focus on a specific time period.



FIGURE 8.28 Use this dialog box to specify a time

frame to display in the Calendar view.

FIGURE 8.29 Use the Layout dialog box to change

the way that Project presents tasks in the Calendar

view.

FIGURE 8.30 When multiple tasks appear on the

same day, Project displays a small black arrow in the

upper-left corner of the day.

FIGURE 8.31 Select Copy Picture to create a graphic

image you can paste into any application.

FIGURE 8.32 Choose the For Screen option to copy a

Project schedule to the Windows Clipboard.

FIGURE 8.33 After you use the Copy Picture

command to render an image for the screen, you can

paste the image into any document.

FIGURE 8.34 You can click this button to open the

Insert Picture dialog box and add a picture to a

header.

FIGURE 8.35 Select the file you want to associate

with a task.

FIGURE 8.36 The information in the file appears as a

graphic object on the Notes tab of the Task

Information dialog box.

FIGURE 8.37 You can copy any image that you placed

on the Windows Clipboard into Project.

Chapter 9: Reporting on Progress

FIGURE 9.1 You set up print information in the

Backstage view.

FIGURE 9.2 The Page tab of the Page Setup dialog

box.



FIGURE 9.3 The Margins tab of the Page Setup

dialog box.

FIGURE 9.4 The Header tab of the Page Setup dialog

box.

FIGURE 9.5 The Legend tab of the Page Setup dialog

box.

FIGURE 9.6 The View tab of the Page Setup dialog

box.

FIGURE 9.7 Select a report category from the

Reports dialog box.

FIGURE 9.8 A preview of a report in Backstage view.

FIGURE 9.9 The reports available in the Overview

category.

FIGURE 9.10 The Project Summary report.

FIGURE 9.11 The Top Level Tasks report.

FIGURE 9.12 The Critical Tasks report.

FIGURE 9.13 The Milestones report.

FIGURE 9.14 The Working Days report.

FIGURE 9.15 The reports available in the Cost

category.

FIGURE 9.16 The Cash Flow report.

FIGURE 9.17 Use the Crosstab Report dialog box to

change the default settings for the report.

FIGURE 9.18 The Earned Value report.

FIGURE 9.19 The Budget report.

FIGURE 9.20 The Overbudget Tasks report.

FIGURE 9.21 The Overbudget Resources report.



FIGURE 9.22 The reports available in the Current

Activities category.

FIGURE 9.23 The Unstarted Tasks report.

FIGURE 9.24 The Tasks Starting Soon report.

FIGURE 9.25 The Tasks in Progress report.

FIGURE 9.26 The Completed Tasks report.

FIGURE 9.27 The Should Have Started Tasks report.

FIGURE 9.28 The Slipping Tasks report.

FIGURE 9.29 The reports available in the

Assignments category.

FIGURE 9.30 The Who Does What report.

FIGURE 9.31 The Who Does What When report.

FIGURE 9.32 The To Do List report.

FIGURE 9.33 The Overallocated Resources report.

FIGURE 9.34 The Workload Reports dialog box.

FIGURE 9.35 The Task Usage report.

FIGURE 9.36 The Resource Usage report.

FIGURE 9.37 The Custom Reports dialog box.

FIGURE 9.38 The Task report.

FIGURE 9.39 The Resource report.

FIGURE 9.40 The Crosstab report.

FIGURE 9.41 Use the Report Text dialog box to

change the font of the report items.

FIGURE 9.42 Use the Definition tab to change the

report’s table or filter.

FIGURE 9.43 Use the Details tab to specify the

information you want to include on the report.


